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1. Getting Started
1.1 About This Guide
The purpose of this document is to support a self-guided, hands-on evaluation of VMware vCenter™ CapacityIQ 1.5. 
This document is intended to provide IT professionals with the necessary information to analyze, optimize, and 
forecast the capacity needs of their virtual datacenter environment using VMware vCenter CapacityIQ. 

The content includes a product overview, configuration options, and key use cases to demonstrate how 
CapacityIQ provides visibility into available capacity, enables the efficient usage of existing capacity, and 
predicts future capacity needs of your virtual infrastructure. Using CapacityIQ, you can make informed, risk-free 
decisions to ensure that your virtual infrastructure has sufficient capacity to meet any business service-level 
agreements. 

1.2 How to Use this Guide
This guide will walk you through some key use cases for CapacityIQ to help you conduct a successful product 
evaluation. A worksheet provided at the end of this guide will help you track your progress.    

A glossary of terms is also available to help explain unfamiliar terms.

1.3 Help and Support During the Evaluation
This guide is not intended to be a substitute for product documentation. For detailed information regarding 
installation, configuration, administration, and usage of VMware products, please refer to the online 
documentation. You may also consult the online Knowledge Base if you have any additional questions. Should 
you require further assistance, please contact a VMware sales representative or channel partner. 

Below are some links to online resources, documentation, and self-help tools:

VMware vSphere and VMware vCenter Server Resources:
•	Product Overview 

http://www.vmware.com/products/vsphere/

•	Product Documentation 
http://www.vmware.com/support/pubs/vs_pubs.html

•	White Papers and Technical Papers 
http://www.vmware.com/resources/techresources/

CapacityIQ Resources:
•	Product Overview 

http://www.vmware.com/products/vcenter-capacityiq/

•	Product Documentation 
http://www.vmware.com/support/pubs/capacityiq_pubs.html

•	Managing Capacity Using VMware vCenter CapacityIQ (White Paper) 
http://www.vmware.com/resources/techresources/10156

•	CapacityIQ Community 
http://communities.vmware.com/community/vmtn/mgmt/capacityiq

•	Support Knowledge Base   
http://kb.vmware.com

http://www.vmware.com/products/vsphere/
http://www.vmware.com/support/pubs/vs_pubs.html
http://www.vmware.com/resources/techresources/
http://www.vmware.com/products/vcenter-capacityiq/
http://www.vmware.com/support/pubs/capacityiq_pubs.html
http://www.vmware.com/resources/techresources/10156
http://communities.vmware.com/community/vmtn/mgmt/capacityiq
http://kb.vmware.com
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2. What is VMware vCenter CapacityIQ?
VMware vCenter CapacityIQ is a capacity management solution for VMware vSphere™ 4.x (“vSphere”) 
deployments enabling users to analyze, optimize, and forecast the capacity needs of their virtual datacenter 
environment. CapacityIQ provides Virtual Infrastructure (VI) administrators with visibility into their infrastructure 
capacity—what is currently available, what is in use, what will be needed in the future, and when capacity will  
run out.

VMware virtualization enables a shared, dynamic environment—with pools of resources and capacity that can 
shrink or expand on demand. This constantly changing environment provides an opportunity for better, more 
effective capacity management. In order to bring science to the art of capacity planning for virtualized 
environments, users need a purpose-built tool that enables automated, continuous capacity intelligence to 
empower informed decision making. VMware vCenter CapacityIQ provides the following key features for such 
just-in-time capacity planning:

Capacity Awareness
•	This dashboard features at-a-glance charts and graphs. View and analyze past, present, and future capacity 

states.  Leverage the dashboard to quickly review dynamic capacity demands and ensure real-time tuning.

•	Customized capacity thresholds and alerts let you turn your datacenter capacity on autopilot by specifying 
rules, settings and alerts. Eliminate any timely and costly routine monitoring and management tasks through 
automation.

Capacity Optimization
•	Detailed reports with recommendations let you reclaim excess capacity from idle, oversized, or powered-off 

virtual machines. Each capacity report provides detailed supporting data to help with any right-sizing or 
decommissioning decisions.

•	Smart capacity profiler and advisor enables you to size and allocate capacity for each VM based on historical 
and future needs. Additionally, these virtual machines can then be placed and stacked in the most optimal 
cluster to eliminate any further waste. 

Capacity Prediction
•	Interactive “what-if” modeling scenarios simulate one-off business events to derive the best-fit outcome. Input 

company-, situation-, or project-specific data points to quantify potential business impact.

•	Contextual capacity forecasts identify the exact timing of potential capacity shortfalls based on business-as-
usual trends and predictions—specific to your datacenter or desktop environments. Purchase and provision 
capacity as and when needed.

VMware vCenter CapacityIQ is shipped as a virtual appliance—a pre-configured virtual machine image that 
contains an operating system and application software in a ready-to-use configuration—that you install in your 
vSphere environment. The virtual appliance includes the following components: 

•	CapacityIQ Administrative Server—provides a user interface for the CapacityIQ system administrator to 
configure and maintain the virtual appliance

•	CapacityIQ Server—hosts an operating system and the CapacityIQ application

•	Database Server—stores performance data collected from objects managed in vCenter

•	Data Collector—collects inventory and performance data 
 
 
 
 



W H I T E  P A P E R  /  5

VMware vCenter™
CapacityIQ Evaluator’s Guide

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 
 
 
 

Data Disk

System Disk

VC Database

22

80

443

5480

8080

8443

9080

9443

CapacityIQ
Administrative

Server

Data
Collector

vSphere
Client

vSphere Client

vCenter
License
Server

vCenter

vCenter Server

CapacityIQ
Plug-In

SSH

CapacityIQ
Server

Database
Server

HTTP Redirect

port fowarding

SQL SQL

vSphere
Client

 
Figure 2.1. VMware vCenter CapacityIQ Architecture Overview.

The VMware vCenter CapacityIQ user interface is provided as a plug-in to the vSphere Client. You can  
access vCenter CapacityIQ through any instance of vSphere Client that connects to your vCenter Server.  
No changes to your vCenter setup, such as modifying the logging levels, are required. CapacityIQ begins 
collecting performance data shortly after installation using standard vSphere APIs. Data collection remains 
continuous unless you stop CapacityIQ.

vCenter CapacityIQ collects performance information about managed objects, such as hosts and virtual 
machines in the vSphere environment, which is then stored in the CapacityIQ database.  Users query the 
database to understand available capacity in the vSphere environment. The main tasks that CapacityIQ 
performs are the following:

1. Collects performance statistics about managed objects in the vSphere environment

2. Stores the statistics in the CapacityIQ database and builds a performance history for each object

3. Retrieves and presents the statistics on demand through the CapacityIQ user interface

4. Allows users to filter the information presented and to modify the date range of data viewed to target 
specific objects, time periods, or types of activity

5. Models potential changes to the vSphere environment using “what–if” scenarios
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You can start evaluating CapacityIQ in four easy steps:

1. Install it as a virtual appliance.  Since virtual appliances are preconfigured, deploying CapacityIQ is simple, 
reducing unnecessary time and expenses.

2. Access CapacityIQ from vSphere Client. Review the dashboard to get an at-a-glance view of past, present 
and future capacity needs and availability.

3. Use What–if Scenario wizards to model one-time potential impacts to your datacenter or desktop 
infrastructure capacity.

4. Export or print reports. Generate real-time capacity reports to management or staff.

The next sections in this guide discuss these four steps in detail.

3. System Requirements
3.1 Hardware Requirements
Note: CapacityIQ is typically configured in an existing environment and does not require an isolated dedicated 
environment for evaluation purposes. The recommended hardware and software stated below is intended for 
sites that want to evaluate CapacityIQ in an independent environment that’s different from an existing virtual 
infrastructure setup.

The minimum hardware requirements for a successful evaluation include the following components:

•	At least one physical server should be used to install ESX®. See the VMware ESX 4.0 hardware compatibility list 
for supported server models. vCenter Server and CapacityIQ run as virtual machines on this ESX server.

•	One Windows workstation or laptop should be used to connect to the vCenter Server using the locally installed 
vSphere Client. 

HARDWARE 
REQUIREMENTS 
FOR VMWARE 
VCENTER 
CAPACITYIQ 
EVALUATION USE 
CASES

MINIMUM RECOMMENDED HARDWARE USED IN THIS 
GUIDE

Number of ESX 
server hosts

1 Minimum of 2 ESX 
servers for a small 
virtual machine 
population 
environment

4 (the CapacityIQ virtual 
appliance and the sample 
applications shared the  
4 servers)

CPU 2 dual-core 
processors of 
2400MHz

2 dual-core 
processors of 
2400MHz

2 quad-core processors of 
2500MHz

Memory 8GB 16GB 16GB

Disk space 500GB (SAN/
Local)

Multiple datastores 
(ranging from 
300GB to 1TB each 
in size)

4 datastores (1 x NFS, 1 x iSCSI, 2 
x FC — each one is 300GB to 
500GB in size)

Network 1 gigabit NIC 1 gigabit NIC 1 gigabit NIC
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The CapacityIQ virtual appliance has following hardware requirements:

•	2vCPU on a 2.4GHz or faster CPU

•	3600MB RAM

•	258GB HDD for vSphere 4.x with thick disk provisioning

3.2 Software Requirements
CapacityIQ supports the following ESX and vCenter versions:

•	ESX Server 3.0.2 or higher

•	VMware vCenter Server 4.0 or higher

The CapacityIQ Admin Portal supports the following browsers:

•	Internet Explorer 6.0.x, 7.0.x, and 8.0.x

•	Mozilla Firefox 2.0.x and 3.x

Please see the CapacityIQ product page for the latest compatibility matrices.  
http://www.vmware.com/products/vcenter-capacityiq/.

For the purpose of this evaluation, you can download the latest versions of the following software:

•	VMware vSphere 4.1 (Standard/Enterprise/Enterprise Plus) Evaluation copy

•	VMware vCenter Server 4.1 Evaluation copy

•	VMware vCenter CapacityIQ 1.5 Evaluation copy

VMware offers a free 60-day evaluation of the below VMware software. Follow the instructions at  
http://www.vmware.com/go/try-vcenter-capacityiq where you will be able to download the necessary  
licenses and the following binaries:

BINARY USAGE

VMware vSphere 4.1 (iso file) You can create a boot CD from this iso file and use this 
CD to boot your server and install ESX 4.1

VMware vCenter Server 4.1  (zip file) The zip file includes an installer for VMware vCenter 
Server 4.1

VMware vCenter CapacityIQ 1.5 (zip file) The zip file includes an OVF for vCenter CapacityIQ 
1.5.  Extract the contents to the temporary folder and 
launch an executable file to start the install.

http://www.vmware.com/products/vcenter-capacityiq/.
http://www.vmware.com/go/try-vcenter-capacityiq
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3.3 Software Installation and Configurations
Before you embark on the evaluation exercises, you need to install and configure the software listed in section 
3.2. The table uses time estimates based on the hardware used to write this guide. 

STEP INSTALLATION AND CONFIGURATION DETAILS TIME ESTIMATE

1. Provision four physical servers with the hardware profile 
described in Step 3.1

Varies

2. Install ESX Server software on four physical servers, including 
storage configuration. (See ESX Server 4.1 Installation Guide 
for more details)

45 minutes per ESX host

3. Install VMware vSphere Client on a supported Windows 
machine (e.g., a laptop)

20 minutes

4. Create a virtual machine on one of the ESX hosts using the 
VMware vSphere Client and install Windows Server 2008 on 
it.
Virtual machine configuration:
Operating System: Windows Server 2008 64-bit 
CPU: 2vSMP
Memory: 4GB
Disk: 40GB thick provisioned
Network: 1 NIC card

60 minutes

5. Install VMware vCenter Server on the newly created Windows 
Server 2008 virtual machine created in Step 4.

30 minutes

6. Start the VMware vSphere Client on your client machine and 
connect to the VMware vCenter Server just created in Step 5. 
Add the ESX hosts provisioned in Step 2 to the VMware 
vCenter Server inventory.

10 minutes

7. Create test virtual machines (preferable from already created 
template virtual machines to save time) that will be used as 
the source for capacity analysis and planning. 
For demonstration purposes, this guide uses several virtual 
machines, with a combination of different supported OS 
types. 

20 minutes if from 
templates, 60 minutes if 
from ISO

Total estimated time: 5-6 
hours excluding server 
provisioning time in Step 1

After you have successfully configured ESX, vCenter and sample virtual machines, you can now proceed with 
CapacityIQ installation. 
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3.4 CapacityIQ Installation and Configuration
Before installing VMware vCenter CapacityIQ, you need to ensure the prerequisites listed in the CapacityIQ Pre-
Install checklist below are met. Completing this checklist will ensure you are ready to proceed with the 
CapacityIQ setup.

# DESCRIPTION YES/NO

1. You are using compatible ESX and vCenter versions (ESX Server 3.0.2 or higher and 
vCenter Server 4.0 or higher are supported). The services for vCenter Server and 
VMware Virtual Center Management Web services are running on the vCenter Server.

2. You have the IP address and username and password credentials of the vCenter Server.

3. You have created a new role in vCenter with CapacityIQ privilege and assigned the new 
role to users and set permissions.

4. You have opened the appropriate TCP ports that CapacityIQ needs.

5. You have adequate disk space and system resources for CapacityIQ virtual appliance 
(CapacityIQ requires 2vCPU, 258GB of HDD, and 3600MB RAM).

6. You have downloaded the CapacityIQ virtual appliance (in OVF format).

  

The following table describes TCP ports that CapacityIQ accesses, in order to meet the TCP ports prerequisite 
listed in Step 4 above.

PORT NUMBER DESCRIPTION

22 Port 22 must be open to enable SSH access to the CapacityIQ virtual appliance

80 Admin Portal HTTP server port (forwards to port 9080)

443 Admin Portal HTTPS server port (forwards to port 9443)

5480 HTTP server port for the VMware Studio version of the Admin Portal

8080 CapacityIQ HTTP port

8443 CapacityIQ HTTPS port



W H I T E  P A P E R  /  1 0

VMware vCenter™
CapacityIQ Evaluator’s Guide

CapacityIQ also uses following listening ports, but does not require an opening in your firewall.

PORT NUMBER DESCRIPTION

5432 PostgreSQL server port (listens to connections from local host only)

5488, 5489 Ports used by the VMware Studio version of the Admin Portal

8005, 9005 Admin Portal HTTPS server port (forwards to port 9443)

9080 Apache Tomcat management ports for the Admin Portal

8080 Admin Portal HTTP port

9443 Admin Portal HTTPS port

The following steps provide an overview of CapacityIQ installation:

1. In vSphere Client, import the CapacityIQ appliance distributed as an OVF file using File > Virtual Appliance 
> Import.

2. In the vSphere Client inventory panel, select the virtual machine icon for the imported appliance and start 
the virtual machine. Then click the Console tab and proceed through the Linux-based installation script. 
When the script ends, a URL appears in the format https://<IP address of the virtual appliance>: 5480. You 
need this information for Step 4.

3. On the Console tab, configure the network and time zone settings.

 Do the remaining installation tasks using the CapacityIQ Admin Portal. The Admin Portal is a user interface 
for CapacityIQ administration tasks and is available from the URL provided at the end of Step 2.

4. Open a browser and log in to the Admin Portal.

5. Configure the settings to register CapacityIQ with vCenter Server.

6. Create and upload the SSL certificate, if needed.

7. Apply the CapacityIQ license. From the Admin Portal, you can install a CPU-based license or convert a 
CPU-based license to a virtual machine–based license. If you obtain a virtual machine–based license for 
CapacityIQ, install and manage the license from vCenter Server. Virtual machine–based licenses require 
vCenter Server 4.1 or later versions.

8. Restart vSphere Client.

9. Verify the installation by clicking vCenter CapacityIQ in the vSphere Client toolbar to open the CapacityIQ 
user interface.

Please refer to the VMware vCenter CapacityIQ Administration Guide for any further details.

A few items to be aware of regarding CapacityIQ installation:

1. After you register CapacityIQ with vSphere Client on the Admin Portal Setup tab, you must restart vSphere 
Client. If you do not restart vSphere Client after registration, the vCenter CapacityIQ icon does not appear 
in the vSphere Client.

2. As a best practice, time-synchronize CapacityIQ virtual appliance with the ESX Server that is hosting 
CapacityIQ. If CapacityIQ is not synchronized, the system time is not synchronized with time on other 
systems in your datacenter. 

http://www.vmware.com/pdf/CIQ_Installation_Guide.pdf
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3. During installation, make sure the CapacityIQ time zone matches the time zone on the vCenter Server 
where the CapacityIQ appliance is installed. Data might be collected across numerous time zones that use 
standard or Daylight Savings Time. To enable you to view data as if it came from one time zone, CapacityIQ 
uses the Set Time zone setting to adjust the date and time associated with the collected inventory and 
performance data. Daily and weekly data are time stamped with the date and time of the vCenter Server 
location where CapacityIQ is installed. Data for monthly and greater intervals uses UTC time. Setting the 
time zone incorrectly during installation of the CapacityIQ appliance will result in time stamping errors for 
views and reports.

4. When you first start CapacityIQ, it needs time to collect the initial inventory and performance data and 
display it on the dashboard. It might take up to an hour or so for inventory and performance data to 
populate the dashboard.

In the next section, the key use cases for CapacityIQ are covered.

4. vCenter CapacityIQ Use Cases
This section outlines the most common use cases for vCenter CapacityIQ and lists the recommended steps for 
each case. The following use cases are covered:

•	Understand the current state of capacity 
– How much capacity am I using right now? 
– How much capacity is remaining? 

•	Understand capacity usage trends and forecast future capacity demands 
– How many more virtual machines can I add? 
– When will I run out of capacity?

•	Optimize the use of existing capacity 
– How much capacity can I safely reclaim? 
– Which virtual machines in my environment are idle or should be retired?

•	Plan capacity to meet forecasted demands 
– What happens to my capacity if I add more virtual machines? 
– What happens to my capacity if I add more ESX hosts?

4.1 Understand the Current State of Capacity
The first step to capacity planning exercise is to understand the current state of capacity in your datacenter. 
CapacityIQ analyzes the performance statistics for objects managed in the VMware vSphere environment, such 
as ESX hosts, clusters and virtual machines, to help you understand the current state of capacity in your virtual 
environment. Highlight the datacenter object in the left hand navigation pane, and then click the Dashboard tab.  
Figure 4.1.1 shows the dashboard for the datacenter, VMWDemoDC1, in this evaluation environment. 
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Figure 4.1.1. Dashboard for Datacenter VMWDemoDC1.   

The Dashboard page displays capacity information in two ways:

1. The top half of the page focuses on the managed objects such as clusters, hosts and virtual machines  
in your environment.

2. The bottom half provides information on actual compute resources such CPU, memory, disk  
and network I/O.

The Objects trend and forecast section shows graphical representation of object growth or decline trends over 
past and future time intervals. The Extended Forecast section shows the CapacityIQ forecast of objects in 
tabular format, over an extended time horizon. Together these views provide you the average number of 
objects—clusters, ESX hosts and virtual machines—deployed in your environment. The perspective drop-down 
allows you to change your perspective from Deployed objects to Remaining capacity.

The Resources section focuses on the actual computing resources—CPU, memory, disk and network I/O usage 
in graphical format. The Resources Extended Forecast section provides the information in tabular format over 
an extended time horizon. Similar to the Objects section, you can look at total, used or remaining capacity using 
the perspective drop-down list. This section provides an interactive user interface allowing you to:

•	select physical or virtual capacity sources 

•	aggregate resources as sum or average 

•	display capacity as actual value or in terms of percentages 
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Figure 4.1.2 displays the dashboard with the remaining perspective selected for objects and compute resources. 
It shows the capacity remaining in the VMWDemoDC1 datacenter in graphical and tabular format. 

Figure 4.1.2. Dashboard with Remaining Perspective Selected for Objects and Compute Resources.

The left pane in Dashboard page allows you to select the object whose capacity information you want to view—
you can drill down into specific ESX clusters and ESX hosts to view similar capacity information. Figure 4.1.3 
provides the Dashboard for cluster VMWDemoDC1-Clr0 in the evaluation environment.  
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Figure 4.1.3. Dashboard for Cluster VMWDemoDC1-Clr0.
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Similarly, Figure 4.1.4 shows the dashboard for cluster VMWDemoDC1-Clr0 with remaining perspective selected 
for objects and compute resources.

Figure 4.1.4. Remaining Perspective Selected for Objects and Compute Resources.

Note: Each of these dashboards also provides information on how much time is remaining before capacity is 
exhausted. CapacityIQ analyzes the current deployment trends for the objects, and forecasts this time based on 
the total compute resources used in your environment. CapacityIQ projects time remaining for each of the 
compute resources individually. The Time Remaining displayed for the object is the minimum of all the times 
displayed for the individual resources, since the particular compute resource is likely to be used up first. 

The Datastores List view provides further details on storage analysis done by CapacityIQ. It offers storage 
information in terms of disk space used, and disk I/O read and write throughput, as well as disk I/O read and 
write latency. For disk space used, the view provides a breakdown of disk space that accounts for such files as .
vmdk files, linked clones, or snapshot files. CapacityIQ also performs trending on disk space usage and forecasts 
time remaining based on these projections. Figure 4.1.5 shows the Datastores – List view for cluster 
VMWDemoDC1-Clr0. Check the Glossary for definition of the metrics provided in this view.
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Figure 4.1.5. Datastores – List View for Cluster VMWDemoDC1-Clr0.

The Time Remaining metric is based on the profile of Average Deployed Virtual Machine in the datacenter. To 
see the average deployed virtual machine profile in your environment, click the Views tab and select Average 
Deployed Virtual Machine Profile – Summary view from the drop-down list. Figure 4.1.6 shows that view in the 
evaluation environment.
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Figure 4.1.6. Average Deployed Virtual Machine Profile – Summary View.

CapacityIQ includes several reports to provide capacity analysis details. You also have the option to schedule 
and email these reports. The report schedule is based on vCenter CapacityIQ virtual appliance timezone. You 
must configure SMTP server settings from the vCenter CapacityIQ Administration Portal to activate email 
service. To setup report schedule, click the Reports tab and click New Schedule for the report that you want to 
generate. CapacityIQ provides Schedule Report dialog box to configure schedule parameters that include the 
start date, start hour, and recurrence interval as well as the email addresses separated by commas.
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Figure 4.1.7. Schedule Report Dialog Box.

4.2 Understand Capacity Usage Trends and Forecast Future Capacity Demands
CapacityIQ can help you understand the capacity usage trends in your datacenter and thus help you prepare to 
meet future capacity demands. It analyzes the current resource and object utilization to project these usage 
trends. CapacityIQ provides multiple views to show the historical trends of capacity usage from various 
perspectives—VM and Host deployments, virtual machine, host and cluster capacity usage. You can access 
these views by clicking on the View tab. Note that the list of views will change depending on the type of object 
selected in the navigation pane on the left.  

The Virtual Machine Capacity – Trend view takes into account the current virtual machine deployment and the 
available capacity in terms of average virtual machine profile. The intersection point of the two trend lines points 
to the time remaining before capacity is exhausted.  Figure 4.2.1 shows this view for the VMWDemoDC1-Clr0 
cluster. You can see that this data point matched with the 56 days displayed in the Time Remaining metric in the 
dashboard page shown in the previous section. 
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Figure 4.2.1. Virtual Machine Capacity – Trend View for the VMWDemoDC1-Clr0 Cluster.

The Virtual Machine Capacity – Summary view provides the breakdown for capacity usage trends by each 
resource. This view provides further details to support the CapacityIQ dashboard. It shows remaining capacity 
for each resource separately and then summarizes the result to point out which resource is the bottleneck. 
Figure 4.2.2 shows this view for the VMWDemoDC1-Clr0 cluster.
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Figure 4.2.2. Virtual Machine Capacity – Summary View for the VMWDemoDC1-Clr0 Cluster.
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The Cluster or Host Capacity Usage – Trend view displays historical trends of capacity usage for the physical 
compute resources—CPU, memory, disk and network I/O. This view provides trend lines for individual resource 
utilization metrics. You can use this view to forecast how each resource will be used in the future. Check the 
Glossary for definition of the metrics provided in this view. Figure 4.2.3 shows an example of that view.

Figure 4.2.3. Cluster or Host Capacity Usage – Trend View.

The Virtual Machine Deployment – Trend view provides the current and forecasted trends for virtual machines 
deployed in your environment. Figure 4.2.4 shows an example of that view. Note that these trend lines are based 
on a best-fit analysis, and may not pass exactly through the data points (e.g., the dashboard in the previous 
section shows that an average of 71 virtual machines were deployed in the VMWDemoDC1-Clr0 cluster, and the 
trend line does not pass exactly through that data point).
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Figure 4.2.4. Virtual Machine Deployment – Trend View.

The Host Deployment – Trend view provides similar information regarding the ESX hosts deployed in your 
datacenter. Figure 4.2.5 shows an example of that view. 
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Figure 4.2.5. Host Deployment – Trend View.

The capacity estimates in all these views are based on settings under Global Settings > Capacity and Time 
Remaining, Global Settings > Usable Capacity and Global Settings > Capacity and Trend Analysis > Capacity 
Buffer. Change these settings to values you expect to use in your environment and examine the impact on 
capacity estimates. You can also change the forecast methods used for trending by selecting different methods 
under Global Settings > Trend and Forecast Analysis > Forecast Method.

Note: All trend charts can be manipulated to change the time interval and date range on the bottom horizontal 
axis of the view. You can also change the view from a chart to a table with hard numbers at will by clicking on 
the link in the upper right-hand border of the chart.

4.3 Optimize the Use of Existing Capacity
CapacityIQ can be used to optimize the use of existing capacity in the virtual infrastructure. The ease of 
deploying virtual machines can result in virtual machine sprawl and inefficient use of virtual capacity. CapacityIQ 
includes several views to help you identify unused capacity in your datacenter and clusters. You can reclaim this 
unused capacity to right-size the virtual infrastructure and improve capacity efficiency.  

To begin with, CapacityIQ provides the Virtual Machine Optimization – Summary view that lists the number of 
powered-off, idle, undersized and oversized virtual machines in the selected datacenter or cluster. The view 
provides a quick summary about how efficient the capacity usage is. Based on this information, you can run 
appropriate reports to get more specific lists. You can use these virtual machine lists in the “what-if” scenarios 
that model removing these virtual machines, and verify how much capacity you can safely reclaim in your 
environment.
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Figure 4.3.1. Virtual Machine Optimization – Summary View.

Figure 4.3.2 provides an example of the Oversized Virtual Machines – List view in the evaluation environment. 
For oversized virtual machines, CapacityIQ also provides recommended CPU and memory values to help right-
size these virtual machines. Similarly, Figure 4.3.3 provides an example of the Undersized Virtual Machines – List 
view in the evaluation environment. You can use these results to right-size the virtual machine configurations in 
your vSphere environment and reclaim unused capacity.

You can select a virtual machine from this list and examine its historical capacity usage profile in the views: (a) 
Virtual Machine Capacity Usage – Summary; (b) Virtual Machine Capacity Usage – Trend. 

Note: CapacityIQ analyzes each resource independently to generate the oversized and undersized virtual 
machines lists. Consequently, a virtual machine can show in both lists—for example, a virtual machine can be 
undersized on memory and oversized on CPU.
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Figure 4.3.2. Oversized Virtual Machines – List View.
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Figure 4.3.3. Undersized Virtual Machines – List View.

Note: The definition of undersized and oversized virtual machines is based on Global Settings > Oversized and 
Undersized Virtual Machines. Changing these settings will affect the list of virtual machines displayed in these 
views. Figure 4.3.4 provides an example of these settings.

 



W H I T E  P A P E R  /  2 7

VMware vCenter™
CapacityIQ Evaluator’s Guide

 

Figure 4.3.4. Oversized and Undersized Virtual Machine Detection Settings.

Figure 4.3.5 provides an example of the Idle Virtual Machines – List view in the evaluation environment. You can 
see the specific virtual machines as well as the compute resources each virtual machine is consuming. 
CapacityIQ also provides the Powered-Off Virtual Machines – List view to identify powered off virtual machines 
in your environment.

You can use these results in a “what-if” scenario to see the impact of removing these virtual machines. These 
views will help you optimize capacity by identifying wasted capacity in your vSphere environment.
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Figure 4.3.5. Idle Virtual Machines – List View.

Note: The definition of a powered-off and an idle virtual machine is based on Global Settings > Powered-Off 
and Idle virtual machines. Changing these settings will affect the list of virtual machines displayed in these 
views. Figure 4.3.6 provides an example of these settings.
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Figure 4.3.6. Powered-Off and Idle Virtual Machine Detection Settings.

CapacityIQ also provides similar analysis for physical resources—hosts and clusters—in your virtual 
infrastructure. This analysis can help you balance out workloads across physical resources and help plan for any 
hardware purchases. Figure 4.3.7 provides an example of the Stressed Hosts and Clusters – List view in the 
evaluation environment. Similarly, Figure 4.3.8 provides an example of the Underused Hosts and Clusters – List 
view in the evaluation environment. These views also provide recommended CPU, memory and disk space 
values based on actual resource utilization.

Note: As with virtual resources, CapacityIQ analyzes each physical resource independently to generate the 
stressed and underused hosts and clusters lists. Consequently, a host and cluster can show in both lists.  
For example, a cluster can be stressed on memory and underused on CPU.
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Figure 4.3.7. Stressed Hosts and Clusters – List View.



W H I T E  P A P E R  /  3 1

VMware vCenter™
CapacityIQ Evaluator’s Guide

Figure 4.3.8. Underused Hosts and Clusters – List View.

Note: The definition of stressed and underused hosts and clusters is based on Global Settings > Stressed and 
Underused Hosts and Clusters. Changing these settings will affect the list of hosts and clusters displayed in this 
view. Figure 4.3.9 provides an example of these settings.
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Figure 4.3.9. Underused and Stressed Cluster and Host Detection Settings.

4.4 Plan Capacity to Meet Forecasted Demands
CapacityIQ allows you to show impacts in capacity as well as forecasted capacity based on changes you predict 
will happen to the environment.  Those changes could be brought about by increases or decreases either in 
capacity or in demand. CapacityIQ allows you to create “what-if” scenarios, which models out these anticipated 
changes in capacity or demand and shows their impact on current and future capacity levels. The first modeling 
use case shown demonstrates the results when adding demand—in this case introducing more virtual machines 
into the environment. Later it will combine this use case by modeling added capacity to see the combined 
impact on the capacity usage. 

Starting the “what-if” analysis is very intuitive. You can begin a ”what-if” analysis from several different starting 
points, including:

•	The Dashboard

•	Inside a View

The ”what-if” action will be disabled automatically if it is not applicable to the current view or selection. 
CapacityIQ allows a “what-if” analysis for two types of objects—Cluster and Host.

To start the what-if analysis, select the “VMWDemoDC1-Clr0” cluster in the navigation pane on the left. You now 
see a cluster-level view into the current and future state of capacity in terms of Virtual Machines/Hosts/Clusters 
and CPU/Memory/Disk/Network.

Click the “New what-if scenario” link in the upper right-hand corner.
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Figure 4.4.1. Exporting What-If Scenarios.

If you are in the View tab displaying one of the views, select “Create New Senario” under the What-If Scenario 
widget in the upper right-hand area of the view. This will launch the What-If Scenario wizard.
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Figure 4.4.2. Adding What-If Scenarios. 

If you start the “what-if” analysis from the dashboard, CapacityIQ allows you to select a view to apply the  
“what-if” analysis. This step in the wizard is not available if you start “what-if” analysis from an existing view.

 



W H I T E  P A P E R  /  3 5

VMware vCenter™
CapacityIQ Evaluator’s Guide

Figure 4.4.3. Selecting a View for the What-If Scenario.

Click “Next.”

The What-If analysis wizard starts by asking you if you would like to model host, datastore or virtual machine 
changes, as shown below. In the first part, you will model adding more virtual machines into the environment. 

Select “Virtual machines” as the type of capacity change you want to model. Click the “Next” button.
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Figure 4.4.4. Selecting Type of Change. 

CapacityIQ allows you to model three different types of virtual machine capacity change scenarios. The series of 
questions that follow in the What-If wizard depend on the scenario you select. CapacityIQ allows you to model:

•	Adding new virtual machines by specifying their configuration manually

•	Adding virtual machines based on an existing virtual machine’s profile

•	Removing existing virtual machines
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Figure 4.4.5. Selecting Virtual Machine Scenarios.

This case walks through the What-If analysis wizard to model the impact of adding 10 new virtual machines.

Choose the “Add virtual machines by specifying profile of new virtual machines” radio button. This option allows 
you to define the virtual machine profile that will be used for the “what-if” analysis. 

Click “Next.”

The user needs to input the number of virtual machines to be added, virtual machine configuration, and 
expected virtual machine utilization for the analysis engine to use. CapacityIQ supports thick and thin virtual disk 
types as well as linked clones when specifying virtual disk configuration. The wizard provides a summary of 
existing virtual machine configurations for you to use as a reference as you are sizing your virtual machines. 

Choose 10 as your number of virtual machines to add. Use the configuration options shown below for your 
virtual machines.
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Figure 4.4.6. Choosing New Virtual Machine Configurations.

Click “Next.”

Once all questions are answered, you will be asked to review your input and confirm that the action is ready to 
be carried out.  

A summary screen is presented that shows all of the changes that will be applied when you execute the “what-if” 
analysis. The content of this view will change depending on the information you provided. 

Review the proposed changes, and click “Finish” to complete the scenario.
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Figure 4.4.7. What-If Wizard Summary Screen.

This will bring you back to the Virtual Machine Capacity - Trend view. This view will show the impact of the 
changes that you have proposed in the “what-if” analysis. The original scenario is demonstrated in solid lines, 
while the “what-if” scenario is shown in dotted lines. The view shows that when 10 virtual machines are added, 
the VMWDemoDC1-Clr0 cluster runs out of capacity earlier than the 56 days projected based on current 
capacity usage.



W H I T E  P A P E R  /  4 0

VMware vCenter™
CapacityIQ Evaluator’s Guide

Figure 4.4.8. Virtual Machine Capacity – Trend View.

As stated earlier, CapacityIQ allows you to model three different types of virtual machine capacity change 
scenarios. If you decide to model adding virtual machines to the selected Host/Cluster by selecting reference 
one or more virtual machines from the existing population, you are presented with a list of virtual machines that 
can be selected. The configuration of the selected virtual machines is used as a reference for the “what-if” 
analysis.

To model this scenario, you must select the “Add virtual machines using profiles of existing virtual machines as 
models” radio button and click the “Next” button.
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Figure 4.4.9. Modeling Virtual Machine Capacity Change Scenarios.

This will generate a list of current virtual machines existing in the cluster.  You can select virtual machines that 
you want to use as models for the “what-if” analysis and then click “Next.”
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Figure 4.4.10. Selecting Virtual Machine Sample Populations.

The virtual machine(s) chosen now become units of consumption for extrapolation in the model.  The next page 
allows you to specify the number of virtual machines for each chosen virtual machine reference configuration 
that you want to model (for example, in the figure below, 10 virtual machines are selected in the VM Count 
column on the left for each reference virtual machine configuration). This simulates a scenario that models 
adding 10 virtual machines for each of the two reference virtual machine configurations chosen, totaling 20 
virtual machines.
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Figure 4.4.11. Specifying a Mix of New Virtual Machines to Be Added.

The scenario for removing virtual machines is similar to the previous scenario for adding virtual machines based 
on existing profiles.  A list of virtual machines on the selected host or cluster is shown with the ability to select 
the ones you wish to model removing.
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Figure 4.4.12. Specifying Virtual Machines to Be Removed.

CapacityIQ also allows you to combine “what-if” scenarios that include multiple changes to capacity or demand. 
The second part of this use case will model the impact of adding one ESX host and removing a datastore to the 
existing ”what-if” analysis of adding 10 new virtual machines. It will also show how CapacityIQ allows you to 
compare or combine the impact of multiple modeling scenarios.

The “what-if” analysis for updating hosts and datastore configuration works similar to changing virtual machines. 
Click the “Create New Scenario” link again in the What-If Scenario widget to launch the wizard. This time, select 
the “Hosts & Datastores” radio button to simulate changing host and datastore capacity. Click the “Next” button.
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Figure 4.4.13. Modeling Changes to Hosts and Datastores.

CapacityIQ allows you to model changes to hosts and datastores in the following three ways:

•	Add hosts and datastores to the selected cluster:  This scenario will model the effect on capacity of adding 
hosts and datastores to the cluster.

•	Change host and datastore capacity configuration:  This scenario will model the effect on capacity of changing 
host and datastore configuration.

•	Remove hosts and datastores from selected cluster:  This scenario will show you the effects of removing hosts 
and datastores from the cluster.

This case will walk through the What-If analysis wizard to model the impact of adding one ESX host. Click the 
“Add Host” button and then specify the host configuration details. This option allows you to define a host 
configuration and the number of such hosts that will be used for the “what-if” analysis.  The wizard provides a 
summary of existing host configurations for you to use as a reference. 
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Figure 4.4.14. Simulating Adding One ESX Host.

Use the following values to define the host configuration:

•	Number of hosts = 1

•	CPU (cores) count = 8

•	CPU speed (GHz) = 2

•	Memory (GB) = 16

Click the “Save” button to save the host configuration. 
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Figure 4.4.15. Configuring the Host Population.

Click “Next” in the What-If scenario wizard.

Select a datastore to model datastore capacity changes. Click the “Remove Datastore” button. The datastore to 
be removed is striked out. 
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Figure 4.4.16. Configuring the Datastore Population.

Complete the What-If Scenario wizard to return you to the Virtual Machine Capacity – Trend view.  
The scenario then shows you the impact on overall cluster capacity after the proposed change.
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Figure 4.4.17. Virtual Machine Capacity – Trend View.

The Virtual Machine Capacity - Trend view shows the original scenario based on current utilization as well as the 
two “what-if” scenarios modeled. The What-If Scenario widget provides the legend for the lines shown in the 
chart.  As noted earlier, the original scenario shows that the VMWDemoDC1-Clr0 cluster runs out of capacity  
in 56 days—around October 16—based on current capacity usage. When 10 Virtual machines are added, the 
VMWDemoDC1-Clr0 cluster runs out of capacity—around September 23—earlier than the 56 days projected  
in the original scenario. With the hardware changes (adding one ESX and removing a datastore),  
the VMWDemoDC1-Clr0 cluster runs out of capacity—around October 20—based on the current virtual  
machine deployment rate.

To combine the results of the two scenarios, select the “Combine Scenarios” radio button to update the graph.



W H I T E  P A P E R  /  5 0

VMware vCenter™
CapacityIQ Evaluator’s Guide

 
Figure 4.4.18. Showing Combined Impact of Multiple Scenarios.

This view shows the combined impact of both modeling scenarios—adding 10 virtual machines as well as adding 
an ESX host and removing a datastore.

Similar to modeling capacity changes due to virtual machines, CapacityIQ provides multiple options to model 
capacity changes for hosts. You can change host or datastore capacity configuration to show the effect of 
upgrading to new hardware. To do this, select the host or datastore whose configurations need to be changed 
and then define the new hardware configuration. The wizard also provides a summary of existing host 
configurations as a reference. The scenario then shows the impact on overall cluster capacity based on  
proposed hardware changes.

You can also choose the “Remove hosts” button to simulate a reduction in cluster capacity.  A list of hosts in the 
selected cluster is shown with the ability to select the hosts that you wish to remove for the modeling exercise.
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Figure 4.4.19. Removing Hosts.

CapacityIQ also allows you to model the impact of adding datastores. Click the “Add Datastore” button to 
specify the number and size of datastores to be added. The wizard provides a summary of existing datastore 
configurations for you to use as a reference.

Click the “Save” button to save the datastore configuration. 
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Figure 4.4.20. Adding Datastores.
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5. Next Steps
In this paper, the key use cases of CapacityIQ have been presented. Please refer to the VMware vCenter 
CapacityIQ Administration Guide for more details.

5.1 VMware Contact Information
For additional information or to purchase VMware vCenter CapacityIQ, VMware’s global network of solutions 
providers is ready to assist. If you would like to contact VMware directly, you can reach a sales representative at 
1-877-4VMWARE (650-475-5000 outside North America) or email sales@vmware.com.  When emailing, please 
include the state, country, and company name from which you are inquiring. 

5.2 Providing Feedback
VMware appreciates your feedback on the material included in this guide—in particular, any guidance on the 
following topics: 

•	How useful was the information in this guide?

•	What other specific topics would you like to see covered?

•	Overall, how would you rate this guide?

Please send your feedback to the following address: tmdocfeedback@vmware.com, with “VMware vCenter 
CapacityIQ 1.0 Evaluator’s Guide” in the subject line. Thank you for your help in making this guide a valuable 
resource.
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6. Glossary

TERM EXPLANATION

Physical Capacity Physical capacity is the physical resources necessary to run a physical 
machine, including CPU, memory, disk space, disk I/O bandwidth and 
network I/O bandwidth.

Total Capacity Total capacity is the total amount of physical resources provisioned in 
hosts and clusters that compose the virtual datacenter.

Unusable Capacity Unusable capacity is not available for use by virtual machines 
because it is reserved for the following purposes:
•	High Availability (HA) reserves capacity needed to meet VMware 

HA failover commitments when host failures occur
•	ESX overhead capacity is needed to run ESX and its services
A capacity buffer is set aside as a safety margin against sporadic 
spikes in demand

Usable Capacity Usable capacity can be used for work by virtual machines 
without using capacity reserves. Usable Capacity is the value 
used for modeling and forecasting.

Usable Capacity = Total Capacity - Unusuable Capacity

Used Capacity Used capacity is the portion of capacity that is already used by virtual 
machines running in the datacenter.

Remaining Capacity Remaining capacity is the portion of capacity that is available to be 
used by existing or new virtual machines in the datacenter.

Virtual Machine Capacity CapacityIQ translates physical capacity into an abstract measure 
called virtual machine capacity. Describing capacity in terms of 
virtual machine capacity provides a practical way to plan and track 
capacity in a virtual datacenter.

Total Virtual Machine Capacity Total capacity is the sum of used and remaining virtual machine 
capacity.

Used Virtual Machine Capacity Used virtual machine capacity is the number of virtual machines 
already deployed in the datacenter or cluster.

Remaining Virtual Machine Capacity Remaining virtual machine capacity is a measure of the number of 
new virtual machines that can be deployed.

Deployed Virtual Machine Capacity Deployed virtual machine capacity is used virtual machine capacity 
plus the capacity of virtual machines that have been powered-off.

Trend A trend is a view of historical capacity usage from the present looking 
backward into the past. Trends are used to visualize capacity usage 
patterns that help forecast future activity. A trend might show that 
capacity is increasing, decreasing, or remaining the same.

Forecast This is an estimate of capacity usage from the present looking 
forward into the future.

Time Remaining This is the number of intervals during which usable capacity is still 
available. Time remaining ends when usage equals usable capacity.
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TERM EXPLANATION

Interval Time is given in intervals, such as days, weeks, or months, for which 
information on the Dashboard and views display.

Forcast Horizon This is the number of future intervals for which a forecast is 
calculated and is shown in the Dashboards or views.

Deployed and Available Hosts and 
Clusters

A host or cluster is considered used if the host or cluster has been 
deployed in the virtual datacenter and is available to deploy virtual 
machines. A host or cluster is considered a remaining host or cluster 
if CapacityIQ estimates that the host or cluster has capacity for at 
least one new virtual machine.

Total Host Resources Aggregate capacity usage across all hosts contained within the 
managed object.

Total Virtual Machine Resources This is the aggregate capacity usage across all virtual machines 
deployed on the managed object.

Average Cluster Resources This is the aggregate capacity usage across all hosts contained within 
the managed object, averaged per cluster.

Average Host Resources This is the aggregate capacity usage across all hosts contained within 
the managed object, averaged per host.

Average VM Resources This is the aggregate capacity usage across all virtual machines 
deployed on the managed object, averaged per virtual machine.

Total Disk Space Capacity Total capacity in the datastore.

Disk Space Total Used Total usage of the datastore

Disk Space Provisioned Total space that the virtual machine can use.

Disk Space VMDK Used Disk space that the .vmdk file uses.

Disk Space Shared Amount of disk space for shared files, such as linked clones.

Disk Space VMDK Count Number of virtual disks on the datastore.

Disk Space Snapshot Used Disk space that snapshot files use.

Disk Space Total Used Days Remaining Time that capacity is available for the total disk space.

Disk Space VMDK Used Days Remaining Time that capacity is available for the .vmdk file.

Disk Space Provisioned Days Remaining Time that capacity is available for the total space that the virtual 
machine can use.

Disk I/O Read Disk read requests.

Disk I/O Write Disk write requests.

Disk I/O Reads per Second Average number of kilobytes read from disk each second.

Disk I/O Writes per Second Average number of kilobytes written to disk each second.

Disk I/O Read Latency Average amount of time to process a SCSI read command issued 
from the guest operating system to the virtual machine.

Disk I/O Write Latency Average amount of time to process a SCSI write command issued 
from the guest operating system to the virtual machine.
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7. VMware vCenter CapacityIQ Evaluation 
Worksheet
You can use the checklist below to organize your evaluation process. The checklist provides a high-level 
summary of the various CapacityIQ workflows and configuration tasks that should be completed during your 
CapacityIQ evaluation.

Hardware checklist:

•	Physical server compatible with VMware ESX 4.1 Qty: ___

•	Storage (shared/local) >= 500GB

•	One desktop/laptop running MS Windows (e.g., XP/Windows 7)

Software checklist:

•	VMware ESX Server 4.1

•	VMware vCenter Server 4.1

•	VMware vCenter CapacityIQ OVF file

•	License keys for all software components

Installation checklist:

•	VMware ESX Server 4.1 installed on physical server(s)

•	VMware vCenter Server and database installed in a virtual machine or physical server

•	VMware Sphere Client installed on the desktop/laptop running MS Windows

•	Sample virtual machines installed

•	VMware vCenter CapacityIQ installed

•	After you have successfully checked off the lists above, you can proceed to perform the evaluation of VMware 
vCenter CapacityIQ. For each scenario, you can use the corresponding checklist below to ensure that you are 
following the proper sequence.

# USE CASE CapacityIQ VIEWS TO USE YES/NO

1. Understand current capacity 
usage and  trends

How much capacity am I using right now?
How much capacity is remaining?

2. Forecast future capacity needs How many more virtual machines can I add?
When will I run out of capacity?

3. Maximize utilization of existing 
capacity

How much capacity can I safely reclaim?
Which virtual machines in my environment are 
idle or should be retired?

4. Predict impact of capacity 
changes

What happens to my capacity if I add more 
virtual machines?
What happens to my capacity if I add more ESX 
hosts?
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